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提醒： 

λ 当您对 SureFibre 磁盘阵列配置完成后，请及时保存 RAID 控制
器和 RAID磁盘阵列的配置信息，以便在发生信息丢失时及时恢
复； 

λ 当您对 SureFibre 磁盘阵列配置进行修改前，首先将磁盘阵列中
的数据进行备份； 

λ 当您对 SureFibre 磁盘阵列配置进行修改时。一定确保修改的正
确性，并及时将修改后的配置进行保存。 

警告： 

λ 修改或配置 SureFibre 磁盘阵列，有可能导致原来磁盘阵列上保
存的数据破坏或丢失； 

λ 因用户自己的操作导致数据破坏或丢失，联想公司将不承担任何
的责任。 

注意： 

λ 不要轻易修改 SureFibre 磁盘阵列的配置信息，如欲进行此类操
作请向相关的技术专家咨询； 

λ 确保理解配置信息的含义并在专家的协助下对 SureFibre 磁盘阵
列的配置信息进行修改 
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第1章 简介 
 

联想 SureFibre磁盘阵列管理软件 SANtricity Storage Manager主要用于: 

² 监控、管理、维护和配置联想 SureFibre磁盘阵列 RAID控制器以及与控制器
相连接的物理和逻辑磁盘。 

§1.1 SANtricity Storage Manager支持的操作系统 

SANtricity Storage Manager软件支持如下几种操作系统： 

² AIX 
² HP_UX 
² IRIX 
² Linux 
² NetWare 
² Solaris 
² Windows 98/NT/2000 

本手册主要提供Windows系列操作系统下 SANtricity Storage Manager管理软件的安装
配置指南。 

§1.2 SANtricity Storage Manager存储阵列管理方法 

SANtricity Storage Manager软件提供了两种管理方法： 

² Host-agent管理方法 

² 直接管理方法 

Host-agent管理方法 

在 Host-agent 管理方法中，管理工作站通过以太网与主机相连，运行于主机上的 agent
使得管理软件能够通过主机与存储阵列间的 Fibre Channel I/O通道与存储列间通信，完
成监控与管理工作。 

直接管理方法 

在直接管理方法中，管理工作站通过以太网直接与每个控制器相连，监控与管理工作通

过以太网而不是 Fibre Channel I/O通道完成。也可以将服务器主机作为管理工作站。 
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§1.3 SANtricity Storage Manager构成 

SANtricity Storage Manager软件由四个部分构成： 

² RDAC package 

² SMutil package 

² SMagent package 

² SMclient package 

RDAC 

RDAC软件包是主机端必须安装的部分，包含 Redundant Disk Array Controller多路径驱
动。RDAC 多路径驱动主要提供 I/O 路径失效情况下的 failover支持。RDAC 软件包必
须安装在所有与存储阵列通过 Fibre Channel相连的主机上。 

SMutil 

SMutil软件包是主机端必须安装的部分，包含向操作系统注册和映射新建卷所需使用的
工具。SMutil软件包必须安装在所有与存储阵列通过 Fibre Channel相连的主机上。 

SMagent 

SMagent 软件包是主机端可选安装部分，提供 host-agent 管理方法的支持。SMagent 负
责管理软件与存储阵列的通信，通信通过主机与阵列间的 Fibre Channel I/O通道完成。
SMagent软件包必须安装在需通过 Fibre Channel连接提供阵列管理路径的所有主机上。 

SMclient 

SMclient软件包是管理工作站端必须安装的部分，主要包括管理管理存储阵列所需要的
软件工具。SMclient通过捆绑在一起的 Enterprise Management Window (EMW)和 Array 
Management Window (AMW)来定义、监控和管理存储阵列。事件监控器是可选服务，
在 EMW没有运行的情况下仍能够提供事件的监控与通知。只需在一台管理工作站上配
置事件监控器，以防收到重复的事件通知。通常情况下，事件监控器应安装在每日 24
小时工作的管理工作站上。 

§1.4 安装需求 

存储管理工作站 

² 奔腾系列处理器，主频 133MHz或以上； 

² Win98 下内存需求为至少 98MB，Windows NT 与 Windows 2000 下为 128MB，
Windows 2000下建议使用 256MB以上的内存； 

² 以太网卡、网卡驱动程序和一个连通的网络环境； 

² 光驱； 
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² 鼠标、键盘； 

² AGP（推荐）或 PCI视频卡； 

² 最少 800×600显示分辨率，256色，建议使用 1024×768显示分辨率，64K颜色； 

² 安装 TCP/IP协议； 

² 需要使用的磁盘空间：最少 60MB，Windows 2000下需全部磁盘可用空间为 100MB。 

主机 

² RDAC需可用磁盘空间 7MB； 

² Microsoft Virtual Machine需可用磁盘空间 1MB； 

² SMagent需可用磁盘空间 1MB； 

² SMclient需可用磁盘空间 60MB； 

² Windows 2000下需全部磁盘可用空间为 100MB。 
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第2章 软件安装 
 

本手册提供的是 SANtricity Storage Manager版本 8.3x在Windows系列操作系统下的快速安
装指南。更详细的安装与配置信息请参考产品安装手册。 

安装过程是假定用户已经是系统管理员。 

§2.1 本安装指南适用的操作系统 
 
存储管理工作站 

² Windows 98第二版 
² Windows NT Workstation 4.0 with Service Pack 6a 
² Windows NT Server 4.0 with Service Pack 6a 
² Windows NT 4.0 Enterprise Edition with Service Pack 6a 
² Windows 2000 Server with Service Pack 2 
² Windows 2000 Professional with Service Pack 2 
² Windows 2000 Advanced Server with Service Pack 2, 用于集群环境 

 
主机 

² Windows NT Server 4.0 with Service Pack 6a 
² Windows NT 4.0 Enterprise Edition with Service Pack 6a 
² Windows 2000 Professional with Service Pack 2 
² Windows 2000 Advanced Server with Service Pack 2, 用于集群环境 

§2.2 SANtricity Storage Manager的安装 

SANtricity Storage Manager安装光盘提供了基于 GUI的工具 CD Browser来帮助完成安
装过程。 

安装之前： 

首先确认一下本地硬盘是否有 20MB左右的磁盘可用空间，这部分空间用来存放临时文
件，不计算在软件所需磁盘空间的范围内。 

安装过程： 

1. 将安装 CD放入 CD驱动器内，如果 CD Browser没有自动启动，则执行 setup.exe，
启动 CD Browser； 

2. 选择 Installation页； 
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3. 选择 Storage management station installation packages，安装存储管理工作站所需软
件包； 

 

a. 在Win2000下不需重新安装Microsoft Virtual Machine； 

b. 在安装 SMclient时，会弹出对话框询问是否安装事件监控器（Event Monitor），
若有多台存储管理工作站，只需在其中一台上安装即可，通常该台工作站设定

为每日 24小时处于工作状态； 
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c. Windows系列操作系统下，不需安装 Frameworks。 

4. 若安装的是服务器主机，需选择 Host installation packages选项，按顺需安装所需软
件； 

 

a. 在Win2000下不需重新安装Microsoft Virtual Machine； 

b. 安装 RDAC，安装完成后，安装程序会询问是否重启系统，选择 no，在所有
软件安装完毕后再重启系统； 
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c. 安装 SMutil； 

d. 安装 SMagent； 

e. 若需要，安装 SMclient; 

f. Windows系列操作系统下，不需安装 Frameworks。 

5. 选择 Exit退出 CD Browser; 

6. 重启系统； 

7. 如果安装了 RDAC，系统会在重启后检测到新硬件，并提示安装驱动程序，可以在
安装光盘的 hostinstall\rdac\目录下找到驱动程序文件 rdacfltr.sys； 

8. 安装完毕。 
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第3章 启动指引 
本章简要介绍如何启动 SANtricity Storage Manager管理软件以及启动后显示的图形界面。 

§3.1 SANtricity Storage Manager的启动 

如果选用直接管理方法，只需在管理工作站上启动 SANtricity Storage Manager Client即可，
事件监视器作为系统服务已经由系统自动启动；如果选用 Host-agent管理方法，还需首先查
看主机端 Storage Manager Agent是否已经启动，若没有，则手工启动它。 

SANtricity Storage Manager Client的启动 

在Windows98，Windows NT和Windows 2000下，可以通过 Start->Programs-> SANtricity 
Storage Manager Client来启动该软件。启动时，如果 SANtricity Storage Manager Client
中没有定义任何用户需要管理的磁盘阵列或主机，将弹出“Initial Automatic Discovery”
对话框，询问用户是否需要系统自动搜寻磁盘阵列设备和主机设备，如下图所示。如果

选择 no，用户还可以通过 Edit->Add Device选项手工增加设备。 

 

§3.2 SANtricity Storage Manager Client运行界面 

SANTricity 客户端软件有两个主要的窗口：Enterprise Management Window 和 Array 
Management Window。如下图所示： 



联想 SureFibre管理软件 SANtricity 

 

 

 

9 

 

Enterprise Management Window 

Enterprise Management Window是启动 SANTricity客户端软件后最先显示的界面。提供
一个树状管理设备列表（Device Tree），安装 SANTricity客户端的主机是这个设备列表
的根节点。设备管理树能够显示安装 Host-Agent主机系统和直接连接在以太网上的存储
设备。 
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Array Management Window 

若要配置和维护设备列表中的设备，需启动 Array Management Window窗口。对于每一
个独立的存储设备，Array Management管理窗口都不是完全一样的。在Array Management 
Window中有两个标签，显示不同的信息： 

标签 描  述 

Logical/Physical View 分为两个部分：Logical View 和 Physical View. 

Logical View 界面显示的是逻辑设备的情况，磁盘阵
列中卷组和卷的组成情况。 

Physical View 界面显示的是磁盘阵列物理设备的情
况，如控制模块，磁盘模块，并且可以浏览这些物理

设备的状态，如温度等。 

Mappings View 由两个部分组成：Topology View, Defined Mappings 
View. 

Topology View  用一个树状的结构图形显示逻辑设
备和存储分区之间的关系。 

Defined Mappings View 显示的是被选中的逻辑
设备与其它设备的详细映射关系。 
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第4章 功能简述 
本章通过对两个主要窗口Enterprise Management Window以及Array Management Window菜
单及其功能的介绍，来简述 SANtricity Storage Manager管理软件的主要功能。 

§4.1 Enterprise Management Window 

使用 Enterprise Management Window可以做到： 

² 添加和侦测用户需要管理的磁盘阵列； 

² 提供一个直观的图形化管理界面； 

² 利用 Script Editor 完成对所有管理的磁盘阵列的管理任务； 

² 配置日志事件的发送给用户的各种方式（E-mail,SNMP）。 

所有与磁盘阵列配置相关的一些信息都存放在安装 SANTricity客户端的计算机上，存放信
息的文件名为：emwdata.bin。利用这个配置文件，可以对管理的磁盘阵列进行标识，便于
管理。 

如果想要收到磁盘阵列系统的日志报警信息，Enterprise Management Window 必须一直运
行，或者使用 Event Monitor。 

在添加需要管理的磁盘阵列后，可以使用 Enterprise Management Window可以监控磁盘阵列
的各种状态。如果在 Enterprise Management Window监控到磁盘阵列处于非常状态，用户可
以启动 Array Management Window了解更详细的信息，同时还可以通过 Array Management 
Window完成或恢复其它一些管理任务。 

可以使用两种方法在设备树中添加需要管理的设备： 

² 利用自动扫描选项，SANTricity客户端软件能够扫描到同一个子网内的存储设备，
并且把它添加到管理界面中； 

² 使用添加设备选项，通过制定需要管理的存储设备的 IP 地址，将设备添加到管理
界面之中。 

注意：当第一次添加设备的时候，设备显示为“Unamed”。 

Enterprise Management窗口菜单选项如下表所示： 

Menu 描  述 

Edit 通过 Edit 菜单选项，可以增加和删除需要管理的存储设备；配置系统报
警信息和设备的描述。 
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View View下的一些菜单选项可以按照名称、状态、管理类型，设备描述对管
理的存储设备进行排序。（另外一个选项“Partially Managed Devices”） 

Tools 通过工具选项可以让系统自动侦测子网内的存储设备或是重新扫描新增

加到主机中的存储设备，也可以刷新管理界面，启动 Array Management
窗口去管理选定的存储设备。当然也可以打开脚本配置界面进行系统配

置和重新装载保存好的配置文件。 

Help 软件使用的帮助系统 

 

Enterprise Management窗口的工具栏选项如下表所示： 

按钮 描  述 

Automatically detect new 
devices 

 

自动侦测子网内的存储设备 

Rescan selected host for 
new devices 

 

重新扫描接入主机系统中的存储设备 

Synchronize Event Monitor 

 

事件监控 

Add host/device 

 

添加存储设备 

Remove host/device 

 

删除存储设备 

Launch an Array 
Management Window 

 

启动 Array Management 管理窗口 
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§4.2 Array Management Window 

使用 Array Management管理窗口，可以配置和维护存储设备中的逻辑和物理的设备。 

Array Management窗口菜单选项如下表所示： 

Menu 描  述 

Storage 
Array 

Storage Array 菜单选项可以实现一下的一些磁盘阵列管理操作： 

locating indicator lights（定位指示灯） 

configurating the storage array（配置磁盘阵列） 

enabling premium features（增加附加功能） 

starting Recovery Guru（开始故障恢复向导） 

monitoring performance（监控性能） 

downloading firmware and NVSRAM files（更新固件程序） 

changing various settings（修改一些设置） 

setting controller clocks（设置控制器时钟） 

redistributing volumes（重新分配卷） 

running Read Link Status diagnostics（运行状态检测） 

renaming volume（重新命名卷）. 

View View 菜单选项可以改变如下视图的显示状况： 

Logical/Physical（切换到 Logical/Physical视图） 

Mappings（切换到Mappings视图） 

Associated Components（显示关连组件） 

Find（查找设备） 

Find Next（查找下一个） 

Go To (Snapshot and Repository)（选择显示某一个卷的视图） 

Event Log（显示日志事件） 

Storage Array Profile（磁盘阵列设备总览） 
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Mappings Mappings菜单选项可以改变或者建立映射信息： 

Define（定义一个映射） 

Change（修改一个映射） 

Move（移动一个映射） 

Replace Host Port（替换映射中主机端口） 

Show All Host Port Information（显示所有的主机端口信息） 

Delete（删除一个映射） 

Rename.（重新命名一个映射） 

Volume 
Group 

Volume Group 菜单选项可以实现以下的一些卷组管理和操作功能： 

creating volumes（创建卷） 

locating（定位卷） 

changing Redundant Array of Independent Disks (RAID) level or 
controller ownership（改变 RAID级别，或者卷所属的控制器） 

adding free capacity (drives)（增加容量） 

defragmenting free capacity（整理磁盘容量） 

placing controllers online or offline（停止或启动控制器） 

initializing a volume group（初始化卷组） 

reviving a volume group（恢复卷组） 

checking redundancy（冗余校验） 

deleting a volume group（删除卷组） 

Volume Volume 菜单选项可以实现以下的一些卷管理和操作功能： creating
（创建一个卷） 

changing （修改卷的属主和条带大小） 

increasing capacity（增加卷的容量） 

initializing（初始化） 

deleting（删除卷） 

renaming （重新命名卷） 
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snapshot（创建或删除 Snapshot卷） 

properties（显示卷的属性） 

Controller Controller菜单选项可以实现以下的一些管理和操作功能： 

Place（停止或启动控制器） 

Date transfer (I/O)（停止或启动数据传输） 

Change（修改一些参数，Loop ID，Active等） 

running diagnostics（运行诊断工具） 

properties（浏览控制器的属性） 

Drive Drive菜单选项可以实现以下的一些管理和操作功能： 

Locating（定位磁盘）  

hot spare（热交换磁盘的设置） 

failing（错误信息） 

revive（恢复） 

reconstructing（重建） 

initializing （初始化） 

properties（显示磁盘属性） 

Help 显示帮助信息和相关的版本信息 

 

Array Management窗口的工具栏选项如下表所示： 

按钮 描  述 

Create new volumes (and 
volume groups, if applicable) 

 

创建一个新的卷 

View diagnostic event log 打开日志时间显示界面 
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Monitor performance 

 

打开性能监控界面 

Recover from failures 

 

启动故障恢复向导，只有在存储设备处于 Needs 

Attention 状态下显示为 时，此选项才能被选

中。 

Find node in tree 

 

查找定义的设备 
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第5章 参数配置 
本章主要介绍如何创建卷与卷组、如何配置卷的映射、如何通过文件保存和装载配置信息，

最后简要介绍一下附加功能。 

在配置磁盘阵列的时候，首先确定合适的数据保护策略，以及这些存储容量如何被组织分配

使用。这一章将介绍一些基本的卷和卷组的概念和配置方法，对一些更细节的描述，可以查

看相应的帮助文件。 

§5.1 配置卷与卷组 

逻辑卷是由用户为了满足数据存储需要在磁盘阵列上创建的一个逻辑的存储结构，通常建立

在多个物理硬盘的基础之上。通常把创建逻辑卷的一系列物理硬盘的组合称为卷组。一个卷

组拥有RAID级别，容量等特性。用户可以从没有配置的卷组容量中创建一个新的逻辑卷。 

卷与卷组的创建可以通过Create Volume Wizard完成。 

打开所要配置的存储设备的Array Management窗口，点击菜单项Volume Group->Create 
Volume或Volume->Create进入Create Volume Wizard，如下图所示： 

 

1. 在下拉列表中选择主机操作系统类型，点击 OK； 
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2. 选择新建卷的位置，可以使用已存在卷组的剩余空间，也可以使用还没有配置的存
储空间，点击 Next； 

3. 如果选择使用未配置空间，则进入卷组的创建，如下图，选择 RAID级别以及创建
卷组的磁盘，点击 Next创建卷组； 

 

4. 配置新卷的容量与名称，如果其他参数使用缺省配置，则点击 Finish完成新卷的配
置工作，如果需要手工配置参数，选择 Custom Setting单选按钮，点击 Next； 
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5. 配置 Volume高级参数，点击 Finish完成新卷的配置； 

 

6. 系统询问是否还要创建其他的卷，选择 No； 
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7. 完成新卷的创建。 

 

§5.2 卷的映射 

为了使操作系统识别存储阵列上所创建的卷，需要指定逻辑卷与 LUN号之间映射关系。 

在 Array Management 窗口中选择Mapping View页，按下面的步骤配置逻辑卷到 LUN的映
射关系。 

5.2.1 定义主机组 

点击菜单项Mapping->Host Group进入。 

 

5.2.2 定义主机 

在窗口左边的 Topology栏中选中主机组，点击菜单项Mapping->Host进入。 
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5.2.3 定义主机端口 

在窗口左边的 Topology栏中选中主机，点击菜单项 Mapping->Host Port进入，在下拉列表
中选择与主机关联的端口标识，选择主机类型，并给定端口名称。 

 

5.2.4 定义映射关系 

映射关系的定义可以有两种方式： 

² 通过 SANshare Storage Partitioning指定逻辑卷分区 

² 通过 Additional Mapping指定单独逻辑卷的映射 

第一种方式通过 SANshare Storage Partitioning Wizard完成，点击菜单项Mapping->SANshare 
Storage Partitioning进入，如下图，按照Wizard指引完成映射任务。 
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1. 选择映射的主机组或主机； 

 

2. 指定映射的卷及 LUN号码； 

 

3. 完成映射。 

 

如果要单独指定某个卷的映射关系，可以选择第二种方式，点击菜单项Mapping->Additional 
Mapping进入，如下图。 
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在创建完所有的逻辑卷并且设定好逻辑卷到LUN号之间的映射以后，用户必须在主机的操作
系统中运行新加逻辑卷的识别工具，使操作系统能够识别到新划分的逻辑卷。新增加的逻辑

卷的识别与操作系统相关，有的操作系统不支持在运行过程中中识别新添加的逻辑卷。详细

情况请查阅相关的操作系统用户手册。 

§5.3 配置文件的保存与装载 

为了方便配置工作，可将当前阵列的配置信息保存在文件中，并在适当的时机使用该文件重

建原有的配置。 

5.3.1 保存配置信息 

在 Array Management窗口中点击菜单项 Storage Array->Configuration->Save，进行如下操作： 

1. 在警告信息对话框重点击“Yes”； 
2. 在 Save Configuration对话框中，输入要保存配置信息的文件名； 
3. 点击“Save”保存配置文件。 

5.3.2 装载配置信息 

在 Enterprise Management窗口中点击菜单项 Tools->Load Configuration，进行如下操作： 

1. 在警告信息对话框重点击“Yes”； 
2. 在 Load Script对话框中，选择保存配置信息的文件名； 
3. 点击“打开”执行配置文件。 
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注意：执行配置文件会导致清除存储阵列上的数据，并丢失所有映射关系。 

§5.4 附加功能 

SANtricity Storage Manager提供下列附加功能，需要用户购买相应的许可才能使用： 

² SANshare Storage Partitioning 

² Snapshot 

² Remote Volume Mirroring (RVM) 
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第6章 程序监控 
本章简单介绍如何查看与诊断物理设备与逻辑设备状态，如何监控 SANtricity Storage 
Manager管理软件中的事件信息。 

§6.1 Recovery Guru 

磁盘阵列处于“Need Attention”状态时，可以使用 Recovery Guru来查看导致该状态的原因，
和系统建议实施的措施。 

在 Array Management窗口重点击菜单项 Storage Array->Recovery Guru进入，如下图。 

 

§6.2控制器故障诊断 

在Array Management窗口中选中所要诊断的控制器，点击菜单项Controller->Run Diagnostics
进入，点击“Run”进行测试诊断。 
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§6.3环路故障诊断 

在 Array Management窗口中点击菜单项 Storage Array->Run Read Link Status Diagnostics, 点
击“Run”重新读取状态信息。状态数据可保存在文件中以备查询。 

 

§6.4事件监控 

SANtricyty监控所有连接的控制器和其他相关物理设备的运行状况。当一个可识别的行为发
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生时，它的结果就是一个事件，如创建一个主机、物理磁盘的损坏等。事件可用来及时通知

管理员某些重要行为与故障的发生，还可以用来进行故障诊断。 

在 Array Management窗口中点击菜单项 View->Event Log进入事件日志查看窗口。事件日志
可保存在文件中以备查询。 

 


